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Paper Set 1 · 28 May 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
The edge of a cube is 5 cm less than the height of a cuboid. If the
total surface area of the cube is 294 cm2, then the height of the
cuboid is:

A.  7 cm

B.  9 cm

C.  12 cm

D.  15 cm

✓

Q2 Quant
A, B, and C invest ₹50,000, ₹75,000, and ₹1,25,000, respectively, in a
business. After one year, the total profit is ₹1,00,000. How much
more profit does C receive than the profit received by B?

A.  ₹15,000

B.  ₹20,000

C.  ₹30,000

D.  ₹35,000

✓

Q3 Quant
Which of the following ratios is the greatest: 7:35, 12:29, 7:29, and
6:27?

A.  12:29

B.  7:35

C.  6:27

D.  7:29

✓

Q4 Quant
Two cars start from the same point and travel in opposite directions.
If one car travels at 43 km/hr and the other at 87 km/hr, how far
apart will they be after 6 hours?

A.  720 km

B.  780 km

C.  750 km

D.  760 km

✓

Q5 Quant
A shopkeeper mixes two types of rice priced at ₹60/kg and ₹90/kg in
the ratio 2 : 1. Find the price of the mixture per kg.

A.  ₹70

B.  ₹80

C.  ₹74

D.  ₹77

✓

Q6 Quant
If 40% of a number is equal to two-thirds of another number, what is
the ratio of the first number to the second number?

A.  3:5

B.  5:9

C.  9:5

D.  5:3

✓

Q7 Quant
If the price of a laptop is increased by 12% and then further
increased by 18%, what is the overall percentage increase from the
original price?

A.  32.16%

B.  30%

C.  28.25%

D.  31%

✓

Q8 Quant
Which number nearest to 90516 is divisible by 9?

A.  90509

B.  90513

C.  90518

D.  90521

✓

Q9 Quant
A shirt has a marked price of ₹1,200. A shopkeeper allows a 15%
discount on it. What price does the customer pay?

A.  ₹1,000

B.  ₹1,020

C.  ₹1,050

D.  ₹1,080
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Q10 Quant
Pipe M can fill a tank in 12 hours, and Pipe N can fill the same tank
in 24 hours. If both pipes are opened simultaneously, how long will
they take to fill the tank?

A.  6 hours

B.  8 hours

C.  9 hours

D.  12 hours

✓

Q11 Quant
The sum of deviations of all observations from their arithmetic
mean is always ________.

A.  Depends on data

B.  Zero

C.  Positive

D.  Non-zero constant

✓

Q12 Quant
A boat travels 40 km upstream in 8 hours. The speed of the boat in
still water is 8 km/h. What is the speed of the water current?

A.  2 km/h

B.  3 km/h

C.  4 km/h

D.  1 km/h

✓

Q13 Quant
One pipe can fill a tank in 12 minutes while another pipe can empty
the completely filled tank in 24 minutes. If both the pipes are
opened together when the tank is empty, how many minutes will it
take to fill one-third of the tank?

A.  8

B.  16

C.  24

D.  32

✓

Q14 Quant
What smallest natural number should be added to 59036 so that the
sum is completely divisible by 58?

A.  8

B.  5

C.  3

D.  12

✓

Q15 Quant
If the simple interest for 2 years is ₹76 and the compound interest
for the same period is ₹80 at the same rate, what is the principal (in
₹)?

A.  361

B.  356

C.  354

D.  365

✓

Q16 Quant
A quadrilateral ABCD circumscribes a circle and AB = 6 cm, CD = 5
cm, and AD = 7 cm. The length of side BC is:

A.  2 cm

B.  6 cm

C.  4 cm

D.  7 cm

✓

Q17 Quant
By how much is 40% of 50 greater than 30% of 55?6303

A.  3.5

B.  2.5

C.  4.5

D.  1.5

✓

Q18 Quant
A refrigerator has a list price of ₹75000. A retailer purchases it after
receiving two successive discounts of 10% and 32%, and this
becomes his cost price. He wants to earn a profit of 37% on his cost
price. If he allows a discount of 49% on his marked price to
customers, at what price should he mark the refrigerator?

A.  ₹123300

B.  ₹123289

C.  ₹123464

D.  ₹123294

✓

Q19 Quant
The product of two consecutive positive integers is 870. If the
smaller of these two integers is represented by x, which of the
options below will correspond to the equation for finding out the
value of x?

A.  x2 + x - 870 = 0

B.  x2 + x + 870 = 0

C.  x2 - x - 870 = 0

D.  x2 - x + 870 = 0
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✓

Q20 Quant
Two circles with radii 'p' and 'q', respectively, touch each other externally. Let 'r' be the radius of a circle that touches these two circles as well as
a common tangent to the circles. The relation between p, q and r is:

A.  

B.  

C.  

D.  

GA

✓

Q21 GA
Saddle Peak, the highest peak in the Andaman and Nicobar Islands,
is located in which part of the island group?

A.  North Andaman

B.  Middle Andaman

C.  South Andaman

D.  Nicobar Islands

✓

Q22 GA
Which of the following Slogans was given by Bal Ganga Dhar Tilak?

A.  “Swaraj is my birth-right and I shall have it

B.  "Inquilab Zindabad"

C.  "Do or Die" and "Quit India"

D.  "Vande Mataram"

✓

Q23 GA
Who was appointed as the Executive Chairman of the National Legal
Services Authority (NALSA) in November 2025?

A.  Justice Harish Tandon

B.  Justice Vikram Nath

C.  Justice Arun Palli

D.  Justice D. Y. Chandrachud

✓

Q24 GA
Which of the following statements correctly distinguishes a mixture
from a compound?

A.  The components of a mixture can be separated by physical
methods

B.  A mixture is formed by a chemical reaction, but a compound
is not

C.  A mixture has fixed proportions of its components

D.  A compound shows the properties of its constituents

✓

Q25 GA
In April 2026, India's first advanced 3D chip packaging unit was
launched in Bhubaneswar, Odisha. What is the name of this project?

A.  Silicon Integration Packaging Solutions

B.  Heterogeneous Integration Packaging Solutions

C.  Advanced Semiconductor Packaging Initiative

D.  Digital Chip Development Solutions

✓

Q26 GA
Which Odia-language film released in 2025 was noted as the
“highest grossing Odia film of all time” in its initial weeks and
starred Babushaan Mohanty and Archita Sahu?

A.  Charidham

B.  Bou Buttu Bhuta

C.  Mo Bou Mo Gaan

D.  Nadabindu
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Q27 GA
Kaziranga National Park in India is renowned for conserving which
animal species?

A.  Bengal Tiger

B.  One-horned Rhinoceros

C.  Snow Leopard

D.  Asiatic Lion

✓

Q28 GA
Where does the water from Chilika Lake finally flow?

A.  Bay of Bengal

B.  Arabian Sea

C.  Indian Ocean

D.  Red Sea

✓

Q29 GA
Pipili town in Odisha is renowned for which traditional handicraft?

A.  Stone carving

B.  Silver filigree

C.  Appliqué work

D.  Pattachitra

✓

Q30 GA
In the Global Innovation Index (GII) 2025 released by the World
Intellectual Property Organization (WIPO), what is India’s overall
global rank among 139 economies?

A.  28

B.  32

C.  38

D.  42

✓

Q31 GA
The colour convention for the live wire in household wiring in India
is _______.

A.  Green

B.  Black

C.  Red

D.  Blue

✓

Q32 GA
In 2025, which political party emerged as the single largest party
within the NDA in the Bihar Assembly elections by winning 89 seats?

A.  Bharatiya Janata Party

B.  Janata Dal (United)

C.  Rashtriya Janata Dal

D.  Lok Janshakti Party (Ram Vilas)

✓

Q33 GA
The Sustainable Harnessing and Advancement of Nuclear Energy for
Transforming India (SHANTI) Bill, 2025, consolidates and
modernises ____________

A.  Introduction of nuclear-powered vehicles

B.  India’s nuclear legal framework

C.  Government-run research on nuclear energy

D.  International nuclear cooperation agreements

✓

Q34 GA
Which of the following correctly describes a condition under which
the prescribed limit on the number of Arjuna Award awarded in a
given year may be exceeded?

A.  When more than three nominations are received from each
National Sports Federation

B.  Performance of Indian sportspersons in the events like
Olympic Games, during a particular year with approval from
Minister-in charge for Youth Affairs & sports

C.  When at least two awards are given in every discipline
including indigenous sports

D.  When nominations are received from private individuals
beyond the prescribed limit

✓

Q35 GA
Which factor mainly drives surface ocean currents?

A.  Earthquakes

B.  Winds

C.  Volcanoes

D.  Ocean depth

✓

Q36 GA
Which of the following characteristics of plant tissues facilitates
waste storage?

A.  High water content

B.  Presence of dead cells

C.  High sugar content

D.  Presence of chlorophyll
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Q37 GA
Why do streams disappear in the Bhabar region of the Northern
Plains?

A.  High evaporation rates

B.  Sandy soil conditions

C.  Deposition of rocks and boulders

D.  Low rainfall levels

✓

Q38 GA
Which Indian author is best known for pioneering realism in modern
Indian literature through novels like Godan?

A.  Munshi Premchand

B.  Rabindranath Tagore

C.  R.K. Narayan

D.  Mulk Raj Anand

✓

Q39 GA
Which Constitutional Amendment of the Indian Constitution made
free and compulsory education for children aged 6–14 years a
Fundamental Right?

A.  42nd Amendment

B.  62nd Amendment

C.  76th Amendment

D.  86th Amendment

✓

Q40 GA
Which of the following is classified under economic infrastructure?

A.  Health services

B.  Education facilities

C.  Communication systems

D.  Sanitation services

English

✓

Q41 English

Complete the sentence with the most appropriate article:
The advancement of artificial intelligence has raised ethical questions regarding ______ use of
autonomous systems in warfare.
2229

A.  an

B.  the

C.  a

D.  no article needed

✓

Q42 English
Select the option that can be used as a one-word substitute for the underlined group of words.

The cruel treatment over long periods of time resulted in riots against the dictatorial rule.

A.  succor

B.  prosecution

C.  persecution

D.  stimulation
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Q43 English
Select the most appropriate option that rectifies the spelling error in the given sentence.

The film’s interpretacion was subject to wide critical debate.

A.  Interpretation

B.  Interpretacin

C.  Interpretatoin

D.  Interpritation

✓

Q44 English
Select the option that expresses the given sentence in passive voice.

The legal team has been scrutinising every clause of the proposed international agreement.

A.  The legal team has scrutinised every clause.

B.  Every clause is being scrutinised by the legal team.

C.  The proposed international agreement was under scrutiny.

D.  Every clause of the proposed international agreement has been being scrutinised by the legal team.

✓

Q45 English
In the given question, a statement divided into different segments is given. Rearrange all the segments to form a coherent statement.

A) he decided to
B) take a break
C) after working nonstop
D) for five hours

A.  CDAB

B.  DABC

C.  DCAB

D.  ADBC

✓

Q46 English
Identify the antonym of the highlighted word in the sentence.
The witness gave a reluctant response when questioned by the lawyer.

A.  kind

B.  timid

C.  gentle

D.  eager
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Q47 English
Sentences of a paragraph are given below in jumbled order. Arrange the sentences in the correct order to form a meaningful and coherent
paragraph.

P. As a result, many endangered species are now struggling to survive in fragmented ecosystems.
Q. Urban expansion and deforestation have drastically reduced natural habitats.
R. These environmental changes disrupt biodiversity and ecological balance.
S. Human activities have had a profound impact on wildlife across the globe.

A.  SQRP

B.  QSRP

C.  SRQP

D.  RQSP

✓

Q48 English
In the following sentence, a segment is given in capital letters. Select the most appropriate idiom to replace the capitalised words in the
sentence below.

Hard work and persistence always pay off EVENTUALLY, OR AFTER A LONG PERIOD.

A.  in black and white

B.  in the long run

C.  at sixes and sevens

D.  on thin ice

✓

Q49 English
Choose the option that can substitute the underlined idiom seamlessly.

Don’t let the cat out of the bag about the surprise party.

A.  reveal the secret

B.  lock the room

C.  hide the key

D.  spoil the fun

✓

Q50 English
Choose the correct indirect speech conversion of the sentence.
Direct speech: The teacher said to the students, “Do not waste your time.”

A.  The teacher advised the students not to waste their time.

B.  The teacher told the students not waste their time.

C.  The teacher said the students don’t waste time.

D.  The teacher requested the students that they should not waste time.
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Q51 English
Select the most appropriate option to fill in the blank.

The teacher spoke _____ the importance of honesty during the morning assembly.

A.  from

B.  by

C.  about

D.  along

✓

Q52 English

Read the given passage and answer the following questions:

The internet has transformed the way people communicate worldwide. Through emails, messaging apps, and social media platforms, individuals
can connect instantly across continents. Businesses use the internet to reach global markets, conduct online transactions, and interact with
customers. Students and professionals access vast amounts of information for learning, research, and work. However, while the internet provides
numerous benefits, it also carries risks. Online misinformation, cyberbullying, and privacy concerns are common challenges. Overuse of digital
devices can affect mental health and reduce physical activity. Therefore, responsible and balanced internet usage is essential. Parents and
educators should guide young users, while governments should enforce cybersecurity measures. By using the internet wisely, people can
maximize its advantages, maintain social connections, and enhance knowledge without compromising safety or well-being.

What is the best title for the passage?

A.  Internet and Communication

B.  Privacy Issues Online

C.  Email Challenges

D.  Technology Addiction

✓

Q53 English
What is the main theme of the passage?

A.  Responsible internet use

B.  Video games are harmful

C.  Only businesses use the internet

D.  Internet is always negative

✓

Q54 English
What message can be inferred from the passage?

A.  One must avoid all forms of internet use

B.  Social media is addictive and should be banned

C.  Using the internet responsibly benefits society

D.  Emails are an outdated means of communication
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Q55 English
Which fact is stated in the passage?

A.  Internet has no risks

B.  People can connect instantly online

C.  Internet replaces schools

D.  Businesses cannot use social media

✓

Q56 English
Choose the correct antonym of the word “excessive”.

A.  Rigid

B.  Serene

C.  Moderate

D.  Precise

✓

Q57 English
Select the option that is closest in meaning to the opposite of the highlighted word in the given sentence.

After hours of walking, he began to trudge along the muddy road.

A.  Stride

B.  Suffer

C.  Suspend

D.  Wander

✓

Q58 English
Choose the correct form of Simple Future Tense.

A.  I will call you as soon as I arrive.

B.  I will be calling you as soon as I arrive.

C.  I will have called you as soon as I arrive.

D.  I must call you as soon as I arrive.
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Q59 English
Choose the option which best replaces the underlined phrase in the given sentence.
The rules seemed lacking a clear purpose or direction, changing frequently without explanation or logical justification.

A.  strategic

B.  arbitrary

C.  deliberate

D.  systematic

✓

Q60 English
Complete the sentence with a grammatically appropriate verb.

They had ______ the project due to unforeseen circumstances.3939

A.  abandons

B.  abandon

C.  abandoned

D.  to abandoning

Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
କୋଣାର୍କ  ସୂ ର୍ଯ୍ୟ  ମନ୍ଦି ର ଏକ ୟୁ ନେସ୍କୋ ବି ଶ୍ୱ ଐତି ହାସି କ କୀର୍ତ୍ତି ସ୍ଥଳ ଅଟେ ।

A.  The Konark Sun Temple is a UNESCO World Heritage Site.

B.  The Konark Sun Temple is a railway station.

C.  The Konark Sun Temple is a museum in Delhi.

D.  The Konark Sun Temple is a political building.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ସେ ପ୍ର ତି ଦି ନ ସକାଳରେ ଚା' ପି ଅନ୍ତି  ।

A.  He drinks tea every morning.

B.  He drink tea every mornings.

C.  He is drinking tea on every morning.

D.  He drunk tea daily morning.

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଦେଶ ମଧ୍ୟରେ ଜାହାଜଗୁ ଡି କ ମହାସାଗର ଏବଂ ସମୁ ଦ୍ର  ଦେଇ ମାଲସାମଗ୍ରୀ  ପରି ବହନ ପାଇଁ  ବ୍ୟବହୃ ତ ହୁ ଏ ।

A.  Ships are used to transport goods safely across oceans and seas between countries.

B.  Ships is used to transport goods safely across oceans and seas between country.

C.  Ships are used to transport good safely across oceans and seas between countries.

D.  Ship are used transport goods safely across oceans and seas between countries.
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Q64 Odia
ସେ ଟ୍ରେ ନ୍  ଧରି ବାକୁ  ______ ଆସି ଥି ଲେ।

A.  ସାମ୍ପ୍ରତି କ

B.  ବି ଳମ୍ବରେ

C.  ପରେ

D.  ଶେଷ

✓

Q65 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ ।

1930 ରୁ  1933 ମଧ୍ୟରେ ଭାରତର ପ୍ର ଥମ ପ୍ର ଧାନମନ୍ତ୍ରୀ ପଣ୍ଡି ତ ଜବାହରଲାଲ ନେହେରୁ ଙ୍କ ଦ୍ୱାରା ଲି ଖି ତ ସବୁ ଠାରୁ  ଉଲ୍ଲେଖନୀୟ କୃ ତି  ମଧ୍ୟରୁ  ଗୋଟି ଏ ହେଉଛି  "ଗ୍ଲି  ମ୍ପସେସ୍  ଅଫ୍  ୱାର୍ଲ୍ଡ  ହି ଷ୍ଟ୍ରି "। ଏହି
ପୁ ସ୍ତକଟି  ଭାରତର ବି ଭି ନ୍ନ ଜେଲରୁ  ନେହେରୁ  ତାଙ୍କ ଝି ଅ ଇନ୍ଦି ରା ଗାନ୍ଧୀଙ୍କୁ  ଲେଖି ଥି ବା 196 ଟି  ଚି ଠି ର ଏକ ସଂକଳନ । ଏହି  ଚି ଠି ଗୁ ଡ଼ି କ କେବଳ ଇତି ହାସର ପାଠ ଭାବରେ ନୁ ହେଁ  ବରଂ ମାନବ
ସଭ୍ୟତା, ସଂସ୍କୃତି  ଏବଂ ଚି ନ୍ତାଧାରାର ବି କାଶର ପରି ଚୟ ଭାବରେ ଉଦ୍ଦି ଷ୍ଟ ଥି ଲା। ନେହେରୁ , ତାଙ୍କର ବି ଶାଳ ଜ୍ଞାନ ଏବଂ ମାନବତା ପ୍ର ତି  ଗଭୀର ପ୍ରେ ମ ସହି ତ, ଏହି  ଚି ଠି ଗୁ ଡ଼ି କ ଜରି ଆରେ ବି ଶ୍ୱ
ଇତି ହାସକୁ  ଏପରି  ଭାବରେ ବ୍ୟାଖ୍ୟା କରି ଛନ୍ତି  ଯାହା ଉଭୟ ବ୍ୟକ୍ତି ଗତ ଏବଂ ସାର୍ବ ଜନୀନ ଥି ଲା। ଏହି  ପୁ ସ୍ତକଟି  ହଜାର ହଜାର ବର୍ଷ  ବ୍ୟାପି ଛି  - ମି ଶର, ମେସୋପୋଟାମି ଆ ଏବଂ ଭାରତର ପ୍ରା ରମ୍ଭି କ
ସଭ୍ୟତାରୁ  ଆରମ୍ଭ କରି  ଗ୍ରୀ ସ୍  ଏବଂ ରୋମର ମହାନ ସାମ୍ରା ଜ୍ୟ ପର୍ଯ୍ୟ ନ୍ତ, ଏବଂ ଆହୁ ରି  ମଧ୍ୟ ଇସଲାମର ଉତ୍ଥାନ, ୟୁ ରୋପୀୟ ନବଜାଗରଣ ଏବଂ ବିଂ ଶ ଶତାବ୍ଦୀ ପର୍ଯ୍ୟ ନ୍ତ ଆଧୁ ନି କ ବି ଶ୍ୱ ଘଟଣାବଳୀ
ପର୍ଯ୍ୟ ନ୍ତ।

ନେହେରୁ ଙ୍କ "ଗ୍ଲି  ମ୍ପସେସ୍  ଅଫ୍  ୱାର୍ଲ୍ଡ  ହି ଷ୍ଟ୍ରି " ଲେଖି ବାର ଉଦ୍ଦେଶ୍ୟ କେବଳ ଇନ୍ଦି ରାଙ୍କୁ  ଶି କ୍ଷା ଦେବା ନୁ ହେଁ  ବରଂ ବି ଶ୍ୱ ବି ଷୟରେ ଏକ ଏମି ତି  ଦୃ ଷ୍ଟି କୋଣର ପ୍ର ସାର କରି ବା ମଧ୍ୟ ଥି ଲା ଯାହା ଏକତା,
ପ୍ର ଗତି  ଏବଂ ଶାନ୍ତି  ଉପରେ ଗୁ ରୁ ତ୍ୱାରୋପ କରି ଥି ଲା। ସେ ବି ଶ୍ୱାସ କରୁ ଥି ଲେ ଯେ ଇତି ହାସ କେବଳ ଯୁ ଦ୍ଧ ଏବଂ ବି ଜୟର ଏକ ରେକର୍ଡ  ନୁ ହେଁ  ବରଂ ମାନବ ବି କାଶ ଏବଂ ସ୍ୱାଧୀନତା ଏବଂ ନ୍ୟାୟ ପାଇଁ
ସଂଘର୍ଷ ର ଏକ କାହାଣୀ । ଏହି  କାର୍ଯ୍ୟ କୁ  ଅନନ୍ୟ କରି ଥାଏ ନେହରୁ ଙ୍କ ଇତି ହାସ ପ୍ର ତି  ଦୃ ଷ୍ଟି କୋଣ |ସେ ରାଜନୈ ତି କ ଘଟଣାଗୁ ଡ଼ି କୁ  ସାମାଜି କ ପରି ବର୍ତ୍ତ ନ, ବୈ ଜ୍ଞାନି କ ଆବି ଷ୍କାର ଏବଂ ଦାର୍ଶ ନି କ
ଚି ନ୍ତାଧାରା ସହି ତ ସଂଯୋଗ କରନ୍ତି । ତାଙ୍କର ବର୍ଣ୍ଣ ନା ଶୈ ଳୀ ଆକର୍ଷ ଣୀୟ, ଐତି ହାସି କ ତଥ୍ୟକୁ  ନୈ ତି କ ପ୍ର ତି ଫଳନ ସହି ତ ମି ଶ୍ର ଣ କରେ। ଚି ଠି ଗୁ ଡ଼ି କ ନେହରୁ ଙ୍କ ଗଭୀର ମାନବବାଦ ଏବଂ
ଆନ୍ତର୍ଜା ତୀୟତାକୁ  ମଧ୍ୟ ପ୍ର କାଶ କରି ଥାଏ ; ସେ ସମସ୍ତ ଜାତି କୁ  ଗୋଟି ଏ ମାନବ ପରି ବାରର ଅଂଶ ଭାବରେ ଦେଖୁ ଥି ଲେ ଏବଂ ପ୍ରା ୟତଃ ଅତ୍ୟାଚାର କି ମ୍ବା ସାମ୍ରା ଜ୍ୟବାଦ ବି ନା ଏକ ବି ଶ୍ୱ ପାଇଁ  ତାଙ୍କର
ଆଶା ପ୍ର କାଶ କରି ଥି ଲେ।

କାରାଗାର କାନ୍ଥ ପଛରୁ  ଲି ଖି ତ, ପୁ ସ୍ତକଟି  ନେହରୁ ଙ୍କ ବୌଦ୍ଧି କ ସ୍ଥି ରତା ଏବଂ ଆଶାବାଦୀ ଆତ୍ମାର ଏକ ପ୍ର ମାଣ । ତାଙ୍କର ବନ୍ଦୀତ୍ୱ ସତ୍ତ୍ୱେ, ସେ ଜ୍ଞାନ ଏବଂ କୌତୁ ହଳରେ ପରି ପୂ ର୍ଣ୍ଣ  ମାନବ ସଭ୍ୟତାର ଏକ
ବ୍ୟାପକ ଦୃ ଶ୍ୟ ସୃ ଷ୍ଟି  କରି ବାରେ ସଫଳ ହୋଇଥି ଲେ । ବି ଶ୍ୱ ଇତି ହାସର ଝଲକ କେବଳ ଐତି ହାସି କ ଲେଖା ନୁ ହେଁ  ବରଂ ରାଜନୈ ତି କ ଦର୍ଶ ନ ଏବଂ ସାହି ତ୍ୟର ମଧ୍ୟ ଏକ ଉଦାହରଣ ଅଟେ।

"ଗ୍ଲି  ମ୍ପସେସ୍  ଅଫ୍  ୱାର୍ଲ୍ଡ  ହି ଷ୍ଟ୍ରି " ନେହେରୁ ଙ୍କ ଦ୍ୱାରା ଲି ଖି ତ କେତୋଟି  ଚି ଠି ର ଏକ ସଂକଳନ ?

A.  150

B.  196

C.  210

D.  175

✓

Q66 Odia
"ଗ୍ଲି  ମ୍ପସେସ୍  ଅଫ୍  ୱାର୍ଲ୍ଡ  ହି ଷ୍ଟ୍ରି " ରେ ଚି ଠି ଗୁ ଡ଼ି କ କାହାକୁ  ସମ୍ବୋଧି ତ କରାଯାଇଥି ଲା?

A.  ମହାତ୍ମା ଗାନ୍ଧୀ

B.  କମଳା ନେହେରୁ

C.  ଇନ୍ଦି ରା ଗାନ୍ଧୀ

D.  ସରୋଜି ନୀ ନାଇଡୁ

✓

Q67 Odia
ଏହି  ପୁ ସ୍ତକରେ ସଂକଳି ତ ଚି ଠି ଗୁ ଡ଼ି କ କେଉଁ  ବର୍ଷ ରେ ନେହେରୁ  ଲେଖି ଥି ଲେ?

A.  1920–1923

B.  1930–1933

C.  1942–1945

D.  1919–1921

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q68 Odia
"ଗ୍ଲି  ମ୍ପସେସ୍  ଅଫ୍  ୱାର୍ଲ୍ଡ  ହି ଷ୍ଟ୍ରି " ଲେଖି ବାରେ ନେହେରୁ ଙ୍କ ମୁ ଖ୍ୟ ଲକ୍ଷ୍ୟ କ'ଣ ଥି ଲା?

A.  ରାଜନୀତି  ବି ଜ୍ଞାନ ପଢ଼ାଇବା

B.  ତାଙ୍କ ଝି ଅକୁ  ବି ଶ୍ୱ ଇତି ହାସ ଏବଂ ମାନବ ସଭ୍ୟତା ବି ଷୟରେ ଶି କ୍ଷା ଦେବା

C.  ବ୍ରି  ଟି ଶ ଶାସନକୁ  ସମାଲୋଚନା କରି ବା

D.  ଭାରତର ସ୍ୱାଧୀନତା ସଂଗ୍ରା ମକୁ  ଦଲି ଲ କରି ବା

✓

Q69 Odia
ପୁ ସ୍ତକରେ ନେହେରୁ ଙ୍କ ଇତି ହାସ ପ୍ର ତି  ଦୃ ଷ୍ଟି କୋଣକୁ  ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସର୍ବୋ ତ୍ତମ ଭାବରେ ବର୍ଣ୍ଣ ନା କରେ?

A.  କେବଳ ଯୁ ଦ୍ଧ ଏବଂ ସାମ୍ରା ଜ୍ୟ ଉପରେ କେନ୍ଦ୍ରି ତ

B.  ସାମାଜି କ, ସାଂସ୍କୃତି କ ଏବଂ ବୈ ଜ୍ଞାନି କ ବି କାଶ ଅନ୍ତର୍ଭୁ କ୍ତ

C.  ଭାରତୀୟ ଇତି ହାସ ପର୍ଯ୍ୟ ନ୍ତ ସୀମି ତ

D.  ସମ୍ପୂ ର୍ଣ୍ଣ  ପୌରାଣି କ କାହାଣୀ ଉପରେ ଆଧାରି ତ

✓

Q70 Odia
"ଊଣା ହି ଡ ଯେଉଁ ଠି , ପାଣି  ଗଡେ ସେଇଠି "- ଏହି  ଲୋକୋକ୍ତି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  ଯେଉଁ ଠି  ପାଣି  ଥାଏ,ସେଠି  ହି ଡ ଭାଙ୍ଗି ଯାଏ ।

B.  ଦୁ ର୍ବ ଳତା ପରାଜୟର କାରଣ ।

C.  ପାଣି  ସବୁ ଠାରେ ସମାନ ଭାବେ ବହେ ।

D.  ଶକ୍ତି ଶାଳୀ ଲୋକ ସବୁ ଠାରେ ଜି ତନ୍ତି  ।

✓

Q71 Odia
ଯୁ ଦ୍ଧରେ 'ଜୟ' ପରେ ________ ର ସମ୍ଭାବନା ମଧ୍ୟ ଥାଏ।
(ନି ମ୍ନ ରେ ପ୍ର ଦତ୍ତ ଶବ୍ଦ ମଧ୍ୟରୁ  ସଠି କ ଶବ୍ଦ ବ୍ୟବହାର କରି  ଶୂ ନ୍ୟସ୍ଥାନ ପୂ ରଣ କର)

A.  ହାର୍

B.  ବି ଫଳତା

C.  ପରାଜୟ

D.  କ୍ଷତି

✓

Q72 Odia
'ହି ମାଳୟ ପୃ ଥି ବୀର ଉଚ୍ଚତମ ଶୃ ଙ୍ଗ' ଏଠାରେ 'ଉଚ୍ଚତମ' କେଉଁ  ପ୍ର କାରର ବି ଶେଷଣ ଭାବେ ପରି ଗଣି ତ?

A.  ପୂ ରଣବାଚକ ବି ଶେଷଣ

B.  ତୁ ଳନାତ୍ମକ ବି ଶେଷଣ

C.  ବି ଧେୟ ବି ଶେଷଣ

D.  ଅବସ୍ଥାବାଚକ ବି ଶେଷଣ
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✓

Q73 Odia
‘ସ୍ଵର୍ଗ କୁ  ବତୀ ଦେବା’- ରୂ ଢ଼ି ଟି ର ଅର୍ଥ  କଣ?

A.  ପାଗ ବାନ୍ଧି ବା

B.  ସ୍ତ୍ରୀ ରୂ ପ ଧାରଣ କରି ବା

C.  ବଂଶ ରକ୍ଷା କରି ବା

D.  ହାତ ଗୋଡ଼ ବାନ୍ଧି ଦେବା

✓

Q74 Odia
ନି ମ୍ନୋ କ୍ତରେ ଥି ବା ପଦମାନଙ୍କ ମଧ୍ୟରୁ  କେଉଁ ଟି  କ୍ରି  ୟା ପଦ ବାଛ ।

A.  ଭାତ

B.  ଅନ୍ଧାର

C.  ସୁ ନ୍ଦର

D.  ଦେବା

✓

Q75 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ତଦ୍ଭବ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  ଆଇଁ ଷ

B.  ପି ସ୍ତଲ

C.  ବୋତଲ

D.  ବାସନ

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


Computer

✓

Q76 Computer
Before electronic computers were widely available, the Abacus was
one of the earliest known devices used for performing fast
arithmetic calculations. What key purpose did the Abacus primarily
serve in ancient history?

A.  To help people count and calculate sums.

B.  To print documents and images quickly.

C.  To store large amounts of permanent data.

D.  To automate logical decisions (like 'if-then').

✓

Q77 Computer
Which of the following statements about opening documents in MS
Word is correct?

A.  Documents can only be opened from the desktop and not
from other folders.

B.  MS Word allows opening documents from local storage,
cloud storage, or recent documents, and also supports
recovering unsaved files.

C.  MS Word does not provide any feature to open multiple
documents simultaneously.

D.  Documents must be closed before opening any new
document.

✓

Q78 Computer
Which option is used to open an existing spreadsheet in MS Excel
2021?

A.  File → New

B.  File → Open

C.  Insert → Open

D.  View → File

✓

Q79 Computer
Which shortcut key inserts a new slide quickly in PowerPoint 2021?

A.  Ctrl + N

B.  Ctrl + M

C.  Ctrl + Shift + N

D.  Ctrl + S

✓

Q80 Computer
What is meant by E-Mail?

A.  Easy Mail

B.  Express Mail

C.  Electronic Mail

D.  Electronic Message

✓

Q81 Computer
What is the correct relationship between the Internet and the World
Wide Web?

A.  They are exactly the same.

B.  The Web is a part of the Internet that uses browsers to
access information.

C.  The Internet is a part of the Web.

D.  The Web works without using Internet protocols. ​​​​​​

✓

Q82 Computer

Under which tab can we format the text in a
paragraph in MS Excel 2007?

A.  Page Layout Tab

B.  View Tab

C.  Insert Tab

D.  Home Tab

✓

Q83 Computer
Which method allows you to quickly open an application that is
pinned to the Taskbar in MS Windows 10?

A.  Press the Windows key + number corresponding to the
application’s position on the Taskbar.

B.  Right-click on the Desktop and select the application from
the context menu.

C.  Open File Explorer and navigate to the application’s
executable file.

D.  Use the Control Panel and choose 'Programs and Features'.
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✓

Q84 Computer
What is the primary function of the Alt + Tab keyboard shortcut in
Windows?

A.  Open the Task Manager

B.  Switch between open applications

C.  Delete a selected file

D.  Insert a new line in a document

✓

Q85 Computer
MS Excel runs on which of the following operating systems?

i. Windows
ii. macOS
iii. Android
iv. iOS

A.  i, ii, iii and iv

B.  Only i, iii and iv

C.  Only i, ii and iii

D.  Only ii, iii and iv

✓

Q86 Computer
Which key allows you to exit a running slide show at any time in MS
PowerPoint?

A.  Escape (Esc)

B.  Enter

C.  Shift

D.  Ctrl + Q

✓

Q87 Computer
What does inserting a copy of another file in PowerPoint slide
mean?

A.  Copy

B.  Embed

C.  Insert

D.  Comment

✓

Q88 Computer
A user wants to apply a formula to a specific cell in Excel that refers
to data in another part of the worksheet. Which of the following best
describes how Excel identifies the correct location of that data?

A.  By using the worksheet name

B.  By using the cell address made of column and row reference

C.  By matching the colour of the cell

D.  By the order in which the cells are entered

✓

Q89 Computer
The command used to jump to a specific page number in MS-Word
is _______________.

A.  Ctrl+P

B.  Ctrl+R

C.  Ctrl+G

D.  Ctrl+A

✓

Q90 Computer
What is the function of the Control Unit in a CPU?

A.  Perform arithmetic operations

B.  Store data

C.  Direct operation of processor

D.  Input data
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Reasoning

✓

Q91 Reasoning
C, A, T, F, I, S, and H are sitting around a circular table, facing the
centre. F is sitting to the immediate left of T and immediate right of
S. I is an immediate neighbour of both C and H. H is the immediate
neighbour of T. Who is sitting to the immediate right of C?

A.  A

B.  F

C.  S

D.  T

✓

Q92 Reasoning
A man sitting next to a boy said about the boy, “He is my father's
only daughter’s son.” How is the man related to the boy?2438

A.  Son

B.  Mother's brother

C.  Mother's father

D.  Father

✓

Q93 Reasoning
What should come in place of '?' in the given series based on the
English alphabetical order?
BIX WDS RYN MTI ?

A.  HOD

B.  HDO

C.  HDR

D.  HRD

✓

Q94 Reasoning
WISH is related to SEVK in a certain way based on the English
alphabetical order. In the same way, OAYN is related to KWBQ. To
which of the following is GSET related, following the same logic?

A.  DNHV

B.  BOGX

C.  COHW

D.  BPIV

✓

Q95 Reasoning
Seven boxes Q, R, W, T, E, U and Y kept one over the other but not
necessarily in the same order.
Y is kept second from the bottom. Only three boxes are kept
between Y and U. E is kept at one of the positions below Y. Only W is
kept between U and T. Q is kept at one of the positions above U.
How many boxes are kept above W?

A.  1

B.  2

C.  3

D.  4

✓

Q96 Reasoning
What will come in place of ‘?’ in the following equation, if ‘+’ and ‘−’
are interchanged and ‘×’ and ‘÷’ are interchanged?

44 ÷ 3 + 72 × 12 − 6 = ?

A.  111

B.  129

C.  107

D.  132

✓

Q97 Reasoning
In a certain code language, 'HLVD' is coded as '82' and 'YQSU' is
coded as '46'.
What is the code for 'KILE' in the given code language?

A.  84

B.  87

C.  91

D.  96
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Q98 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusion(s) logically follow(s) from the statements.

Statements:
All students are girls.
Some girls are boys.

Conclusions:
(I) All students are boys.
(II) Some students are boys.6102

A.  Only Conclusion (I) follows.

B.  Only Conclusion (II) follows.

C.  Both Conclusions (I) and (II) follow.

D.  Neither Conclusion (I) nor (II) follows.

✓

Q99 Reasoning
Based on the English alphabetical order, three of the following four
letter-cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group?
(Note: The odd man out is not based on the number of
consonants/vowels or their position in the letter cluster.)5675

A.  PR-TW

B.  CE-GI

C.  KM-OQ

D.  IK-MO

✓

Q100 Reasoning
Each vowel in the word EPIDERM is changed to the letter
immediately following it in the English alphabetical order and each
consonant is changed to the letter immediately preceding it in the
English alphabetical order. How many letters will appear exactly
twice in the group of letters thus formed? 752

A.  0

B.  1

C.  2

D.  3
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